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Copyright and disclaimer 
All rights reserved. No parts of this manual may be reproduced in any form without the express 

written permission of Makin AS (Makin). Makin makes no warranties, express or implied, with 

respect to this document or its contents. In addition, the contents of the document are subject to 

change without prior notice. Every precaution has been taken in the preparation of this manual. 

Nevertheless, Makin assumes no responsibility for errors or omissions or any damages resulting 

from the use of the information contained. 

 

Copyright © 2019-2025 by Makin AS. 

Contact the manufacturer: 

Makin AS 
Vognvegen 23  
2072 Dal 
NORGE 

www.Makin3D.com 

E-mail: info@Makin3D.com  

Org. no. 920 323 650 

  

http://www.makin3d.com/
mailto:info@Makin3D.com
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1. Introduction 
1.1. Congratulations on your new product 
You are now ready to work more efficiently and keep the precision at an optimum level. Besides that, 

you will be more eco-friendly by doing the same amount of work in less time. 

The system is designed to show you the information you need on the screen with the greatest 

accuracy. 

At the construction site, you are the expert - Makin’ 3D is the best work companion you can get. 

We at Team Makin wish you all the best with the use of your new system. 

 

 

1.2. Maintenance  
It is recommended to check the system's accuracy regularly.  

 

 

1.3. Storage 
Keep the equipment safe when it's not installed in the machine. The use of a protective case is 

recommended if the tablet and antennas are removed from the machine to secure the devices from 

external stresses such as knocks and bumps. 

 

 

1.4. Cleaning 
The equipment must be cleaned regularly to ensure full functionality over time. 

Cleaning is done by blowing to remove dust, you can also choose to use a damp cloth to wipe the 

tablet. 

Under no circumstances should the equipment be high-pressure washed - neither inside nor outside 

the engine compartment. 
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2. Responsibility 
2.1. Installation 
All installation of the system must be carried out by Makin approved technical personnel. Failure 

caused by unauthorized installation or repair could cause a void of warranty. 

It is important to follow the machine manufacturer's instructions for installing the Makin machine 

control system to avoid violating any machine supplier's warranty regulations. 

The user is responsible for using the product in accordance with the given instructions. The user is 

also responsible for ensuring that the reference models used are correct and that the drum is 

properly controlled. 

Broken cables on the system may cause short circuits, system errors, and defective components. 

Ensure that no cables have external damage; damage must be repaired immediately before further 

use. 

Errors in measurement results may occur if the equipment has been subjected to impact, abuse, 

modification, or transport damage. Control of the system after such events is important to ensure 

an optimum result. 

Warranty: For further details, visit www.Makin3D.com for more information. 

 

 

2.2. Limitations 

The product is intended as a control tool, and any use beyond this is not permitted. The supplier or 

manufacturer cannot be held responsible for any use that goes beyond the given limits. 

 

 

  

http://www.makin3d.com/
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2.3. End-user license agreement 
License: The system is preloaded with software, which can also be downloaded with permission 

from Makin. The software is protected by copyright and other laws. The use of the software is 

governed by the license agreement entered into with the Makin’ 3D system when purchasing the 

product.  

For further legal terms and conditions, including but not limited to the applicable End User License 

Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.  

 
 

2.4. Warranty disclaimer 
Makin provides this documentation without warranty, term, or condition of any kind, either implied 

or expressed, including, but not limited to, the implied warranties, terms, or conditions of 

merchantability, satisfactory quality, and fitness for a particular purpose.  

Makin, its employees, and agents will not be responsible for any loss, however arising, from the use 

of, or reliance on this information. 

 

For further legal terms and conditions, including but not limited to the applicable End User License 

Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.  

 
 

2.5. Software update 
Software will be automatically and frequently updated, and users will get a notification on the screen. 

Software updates require a valid maintenance license. To start downloading an updated software 

version, users will be asked to agree before the download starts. 

 

  

http://www.makin3d.com/
http://www.makin3d.com/
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3. Product overview 
3.1. Hardware Compactor 

Hardware overview 

 

 

 

 
1. 

 
GNSS antenna 5. Docking station for the tablet. 

 
 
2. 

 
CMV sensor 
 

 
6. 

 
GNSS receiver 

 
3. 

 
Body sensor 

 
7. 

 
Interface Box for system power and 
data communication. 

 
4. 

 
Tablet w. machine control 
software 
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3.2. Tablet buttons and light indicators (Panasonic FZ-A3) 
 

 
 
1. 

 
On/Off button 

4. 
 

Quick access to tablet's 
menu  

 
2. 

 
 

Volume up  
5. Not in use. The button can 

be programmed (more info 
below). 

 
3. 

 
 

Volume down 
6. Not in use. The button can 

be programmed (more info 
below). 

 

Additionally, screenshots can be taken by pressing the ‘On/Off button’ and ‘Volume down’ 

(simultaneously holding down buttons 1 and 3 for about two seconds). This can be useful in the 

unfortunate case where assistance is required. Find the screenshots via the ‘Photos’ app. 
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3.3. Software 

3.3.1. How to turn the system on 

1) Turn on your Makin’ 3D system by pressing the on/off button on the tablet. Android will start 

up and present the ‘Lock screen’. 

 
2) Swipe upwards with one finger on the touchscreen to access Makin’ 3D. 

 
3) If no project has been previously loaded, you will be prompted to do so. See Chapter 4.1: 

Open or create a project. 

 

 

3.3.2. Elements of the work screen 

Makin’ 3D offers a variety of screens to choose from. Below is a description of one that includes 

most of the available visual features. 
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1. 

 
Top bar with status indicators for 
connectivity. It also contains selected 
quick keys. 
 

    6. Actual CMV value. 

 

 
2. 

 
Shows the current speed. The box is 
color coded, indicating whether the 
operator is keeping the correct speed. 
 
 

 
    7. 

 
Actual delta CMV value in %. 
 

 
3. 

 
Color codes for the CMV. The colors 
will match the heatmap created on the 
screen.  

 
    8. 

 
Actual passes.  

 
4. 

 
Color codes for the passes. The colors 
will match the heatmap created on the 
screen.  

 
    9. 

 
Height indicator/Tool coordinates. 
Depending on settings set, see 
chapter 5.6: Tool point coordinates 
for more information. 
 

 
5. 

 
Quick key bar. Quick keys are shortcuts 
to features found in the menu. 
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3.3.2.1. Work screen views 
The work screen is divided into two sections. It is possible to choose which two views you 
wish to display during your work: 
 

• CMV and Pass 
• Pass and Section  
• CMV and Section  
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3.3.2.2. Heatmap 
Displayed above is the heatmap produced during the compaction operation. The color 
scheme reflects real-time values and enables monitoring of the process, as it evolves 
alongside the work process. 
 
Please note that the number of colors in the heatmap can vary depending on the 
overviewed displayed. The table below shows the outermost points of the color ranges.  
 

 
Color codes Relation to the target value 

 

 
 

 
 
 
Above target  

 

 
 

 
 
 
On target 

 

 
 

 
 
 
Below target 
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3.3.2.3. Machine speed 
The feature ‘Machine speed’ shows the speed of the machine, working like a speedometer. The 

speed is displayed in kilometers per hour (km/h).  

 

      
 

The speed is color coded, to help the operator stay within the target speed. The table below shows 

examples of the colors seen when the machine is in motion. 

Color codes Relation to the target speed 
 

 
 

 
 
Below the target speed. 

 

 
 

 
 
A little below the target speed. 

 

 
 

 
 
Within the target speed. 

 

 
 

 
 
A little above the target speed. 

 

 
 

 
 
Above the target speed. 
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3.3.2.4. Compaction settings  
The compaction settings menu is used to set relevant values for the compactor. Please 
note that these settings should be set on the tablet, and not on in the cloud.  
 

 
 
 
Target CMV: 
The target CMV, the value set will affect the color codes on the heatmap.  
 
Target Delta CMV:  
The target Delta CMV is displayed in percentage, and the value set will affect the color codes on 
the heatmap. 
 
Minimum/Maximum passes: 
The passes are displayed in the number of passes. If the compactor has moved forwards and 
backwards over an area, this counts as 2 passes. The values set will affect the color codes on the 
heatmap. 
 
Minimum/Maximum speed:  
The speed is displayed in kilometers per hour (km/h). The values set will affect the color codes on 
the speedometer.  
 
CMV calibration: 
Press the CMV calibration button in top of the menu, and follow the steps stated on the screen to 
calibrate the CMV sensor.  
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3.3.3. Touch gestures 
 

Gesture Action 

 

Use one finger to rotate a 3D View. 

 

Use two fingers to pan a Top View or 3D View. 

 

Spread or pinch two fingers to respectively zoom in or out of a Top View or 3D 
View. 

 

Tap to select. 

 

Sometimes it is possible to long-press for further options. 
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3.3.4. Symbols in the top bar 
 

Symbol Function 

 

Indicating a connection to the internet. The symbol appears white when a 
connection is established and gray if there is no connection. 

 

Indicates the number of visible satellites. hRMS (Horizontal Root Mean Square) 
and vRMS (Vertical Root Mean Square) indicate the current GNSS accuracy. 
Tapping the icon will bring you to the GNSS status menu. 

 
Indication of synchronization of data between server and machine. 

 

An indication that you have remote support from Makin. 
This will usually be in connection with a remote support case where you will be 
notified. 

 

Bring your machine back to the center of your screen after zooming and 
panning. 

 

Placed in the upper right corner. Tap for a change of screen, depending on the 
work you are doing and what you want to have in focus. 

 

Indicating project offset. The symbol appears when a project offset is applied 
to the active project. 

 
The tablet is connected to the cloud. 

 
Synchronize to the cloud. 

 
The tablet is not connected to the cloud. 

 
The tablet is disconnected from the cloud because of a secret project. 

 

This symbol is a sensor status indicator. See the pop-up notification for more 
information.  
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3.3.5. Quick keys on work screen 
 

Illustration Menu ID Function 

 

References Tap to access the References menu. Another way to access 
this menu is to select an element in the 3D model. 
 

NB! 
Long hold to access the Project menu. 

 

Compaction 
Config 

Tap to access the compaction settings. 

 

Start logging When pressed, the logging starts with the requirement set 
by the operator. 

 

Stop logging When pressed, the logging stops. 

 

Main menu Menu from where you can access all features of the 
system. 

 

Compactor 
logging status 

Shows that the Compactor logging status is on.  
 
NB! 

When the color of the icon is faded, the function is not 
activated. 

 

Layers menu Opens the Layers menu. 
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Main menu 
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4. Project 
Working according to any kind of design is considered a project, whether it is a simple relative plane 

or referencing lines and surfaces in more complex 3D models. 

 

 

 
 

4.1. Open or create a project 
To open an existing project: 

1) In ‘Project’ tap ‘Open project’ to see all the projects stored. This dialog is automatically 

opened if no project is loaded.  

 



 

                                     Makin' Compactor User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        22 

2) Tap on the project you want to open, and the download starts. 

 

 

 

3) If you want to create your own local project, tap the ‘+’ icon. 

 

 

 

4) Tap on the local project icon. 
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4.1.1. Create a secret project 

You can create a secret project that will only be available on your tablet and will not synchronize to 

the Makin’ Cloud. Secret projects are useful for construction projects needing confidentiality due to 

security, critical infrastructure, or competitive advantages. 

 

1) Go to project > Open project 
 

2) Tap on the ‘+’-symbol 
 

3) Tap on the ‘secret project’ icon 
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4) Name the secret project 
 
The icon in front of the project name indicates that it is a secret project: 
 

 
 
 
 

4.1.1.1. Remote control for secret projects 

If you need support while working on a secret project, you must grant support access to your tablet 

during remote control. The secret project will be disconnected and will not synchronize to the 

Makin' Cloud, as indicated by this icon: 

 

The support staff can see that your system is online on the Makin' Cloud, but they will not have 

access to any details about the secret project. To get support while working on a secret project, 

you need to give access to the support staff. When the support staff initiates remote control, a 

notification will pop up on your tablet: 

 

 

To allow remote control access, tap on the check mark. 
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4.2. Transfer files 
You can transfer files via USB flash drive to secret projects, local projects and cloud projects. You 

can import files to the project and export as-built data from the project. Please note: If you import 

files to a local project or a cloud project, those files will be available on Makin’ Cloud. For more 

details, see section 4.2.1.1: Imported files on Makin’ Cloud. 

 

1) Tap on the ‘transfer files’ icon. 

 

 

 

2) Choose between import to project or export as-built data from the project. Learn more about 

importing and exporting in the sections below. 
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4.2.1. Import to project 
You can import files to the project via a USB flash drive. You cannot import single files but only 

folders from the USB flash drive. Please note: If you import a file with the exact same name as an 

existing file in the project, the new file will overwrite the existing one.  

 
How to import files to the project: 

1) Important: Insert the USB flash drive into the tablet first. 

 
2) Tap on ‘Import to project’. 

 

 
 
 

3) You will now be directed to Android's dialog.  
 

4) The first time you insert the USB flash drive you need to make sure that the USB flash drive 

is selected. Tap on the ‘three stripes’ icon in the top left corner. 
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5) Tap on the name of the USB flash drive to open it. 
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6) Tap on the folder you want to import files from. 
 

 
 

 
7) Tap on ‘select’. Please note: All the files in the folder will be imported. You cannot import 

single files.  
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8) Import of files is completed. You can view the files under References on the tablet.  

 

 

 

4.2.1.1. Imported files on Makin’ Cloud 
When you import files to a local or cloud project, they will be available on Makin’ Cloud. However, 

these files will be stored in your system’s project folder, and not as part of a global project within 

your organization. 

 

How to find imported files on Makin’ Cloud: 

1) Go to Makin’ Cloud > Choose organization > Systems 
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2) Select the system that imported the files. 

 

3) Open the project folder under that system. 

 

 

4) Select the project where the files were imported. 
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5) The imported files will be available in this folder.  

 
 

 

4.2.2. Export as-built 
The USB export function allows you to export locally logged as-built data directly to a USB stick. 

This makes it possible to transfer project data without requiring access to the cloud. 

 

Note: Only the as-built data logged by the current user can be exported. 

 

When performing a USB export, the following files are generated: 

• LandXML file: Contains points and lines from the as-built logging. 

• ZIP file (attachments): Photo documentation for all images linked to the logged points. 

• Compaction data (Only for secret projects, otherwise the data is stored directly in the cloud): 
o Final compaction data: The most recently logged data for each layer. 
o Historical compaction data: All compaction data logged during the project. 

 
 
Steps to Export As-Built Data via USB: 

1) Insert the USB flash drive into the tablet. Please note that it is very important that this is done 

as the first step. 

 

2) Open the menu Open project.  

 

3) Tab the icon displaying the two arrows (Transfer symbol)  
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4) Tap on ‘Export as-built’. 
 

 
 

5) You will now be directed to Android's dialog.  

 

6) Make sure that the USB flash drive is selected. If not, tap the ‘three stripes’ icon in the top left 

corner and select the USB flash drive. 
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7) Tap on the folder where you want to save the as-built data. 
 

8) Tap on ‘Select’. This will export the project’s as-built data to the chosen folder. A pop-up 
notification will indicate that the export is in progress.  

• Please note that in most cases, the process is completed so quickly that this 

notification may not appear. 
 

 
 

 
 

9) The project’s as-built data is now saved in the selected folder on the USB flash drive. When 
the export is complete, a confirmation pop-up will be displayed on the screen. 
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4.2.2.1. Export as-built from Makin’ Cloud 
 

1) Go to the as-built section within the project.   
 

 
2) Open the compactor section 

 

 
 
 

3) Use the filter function to find the relevant data.  
 

 
 

4) Select the data and click the Export button. This will give you the option of choosing the 
format you wish to export your data into.  
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5) Select the CSV format to download the data to your computer. Exporting the data will 
generate the file Compaction Data. The file Historical Data will only be generated if you click 
“Export Full History”.  
 
 
 

 

4.3. Supported file types 

When creating a project, the following file types are supported: 

● LandXML Roadrunner format (XML) 

● Drawing eXchange Format (DXF) 

● Norwegian coordinate and observation format (KOF) 

 

New projects are stored in LandXML format. 
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4.3.1. Project filter 

Note: When Makin’ 3D reaches 170 MB data in size, a warning will pop up, informing you that the 

project is large. This can reduce performance. The file size depends on the complexity and the 

details in the model.  

 
 

If the project reaches 170 MB data in size, part of the model will be shown on your tablet screen near 

the application, while the rest remains hidden. As you move the application around, the visible part 

of the model will adjust to stay aligned with where your application is.  

 

You can choose to load a part of the project file under Project > Project filter or click ‘Filter’ in the 

notification. 

 

 

 

1) Select the folder you want to activate and load by clicking on the button. When the folder is 

activated, the button will turn blue. 
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2) Deselect the folders you do not want to load by clicking on the button in front of the folder’s 

name. When deselecting the folder, the button will turn off. 

 

 
 
 

The activated folders will be loaded and displayed under ‘References' in a petrol blue color, along 

with the files from the folders. 

 



 

                                     Makin' Compactor User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        38 

 
 

 

You can create folders on Makin’ Cloud and then drag your project files into these folders: Makin’ 

Cloud > Project > Choose your project > New folder. 
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4.4. References 
In the ‘References’ dialog, you can choose which part of the 3D model should be active/inactive and 

what should be selected as height references, side references, and alert references.  

• Height references can be points, lines, and surfaces. 

• Side- and alert references can be points and lines. 

 

 

 

•  Click and element symbol to select 
and deselect it. When selected the 
element will be highlighted with 
yellow. 

•  Green is used for elements that may 
reference the height. Press to select 
as reference. Long press will 
deselect all other height references 
selected. 

•  White means an element is visible 
and activated. 

•  Red is an alert reference, which gives 
a warning when the tool is too close 
to the element. Not applicable for 
surfaces. 

•  Blue indicates an element used as 
a side reference. Press to select as 
reference. Long press will deselect 
all other side references selected. 

  

 

As an alternative to going via the menu, you can also find this feature in the Quick Keys menu or by 

selecting any element in the 3D model. 
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4.4.1. Visible reference 

All geometries are visible by default and can be hidden by deselecting the white square next to them, 

beneath the eye symbol. Calculations are only performed according to visible layers. 

 

 

 

For example, if we want to make all roads visible in a group of models, simply check the white box 

to the right of its folder. It will make all roads visible on the screen. If we only want to see one road, 

just activate the white box to the right of the particular road file. 
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4.4.2. Folders 

In the reference examples below, we see all folders containing the project data. In this example, we 
have six folders: 

 
 

 

 

If you enable options (i.e., set visible, side reference, height reference, alert reference) for a folder, 

you enable the option for all models in the entire folder. For example, if you have many road models, 

you may want to open the folder with the small arrow to the left of the folder and only activate the 

road models that you need. 
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Folders are shown in blue text and model files are white. File and folder names are scrollable. 

In the above example, we have opened a folder, which contains several individual files. You can turn 

on all elements of a folder or turn on some details by expanding individual folders. Within the folders, 

you can select specific data to make visible and choose what to actively work against. 

To get an indication of the different model files, side and/or height must be activated. As with 

viewing, you do this by tapping the respective blue and/or green boxes. By enabling visibility, side, 

and height in combinations, you can customize what information you want on the screen. 

 
 
 

4.4.3. Side reference 

Side references are geometries used for side calculations. When models are activated, they have a 

blue color next to them, beneath the symbol with the horizontal arrow in the ‘Reference’ dialog. The 

closest geometry, activated for side reference, will automatically be used. Lines and points can be 

selected as side references - not surfaces. The calculated side distance is the horizontal distance 

to the geometry. 

 
 
 

4.4.4. As-built data 
As-built data is data used for documentation of the performed task. As-built data can be used in 

different ways: to document that the project is built the same way as it was originally designed or to 

document if extra work has been performed, e.g., how much soil is being removed from an area.  

 

The as-built data is collected when the machine works, and the data is logged by the operator. This 

data can be used later in the process to assure the quality of the project. As-built points will be saved 

in the overview if it is necessary to navigate to the points at a later stage of the project.   

As-built data can be used as references in a similar way as other references. The green points are 

your own points, and the purple points are points from other applications. The lines and points are 
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continuously saved and synchronized to the Makin’ Cloud, where they can be downloaded as .CSV 

format. 

 
 
 
 
 

4.5. Infield Design  
To open the Infield Design function, go to the Reference menu.  

 

1. Click the + icon on the menu bar in top of the Reference menu.   

2. This will open a drop-down menu. Select the Infield Design icon.  

 

 

 

3. Wait for the Infield Design section to open.  
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4.5.1. Points and lines in Infield Design 
The Infield Design is equipped with an Add point- and an Add line-button.  

 

 

Use these to add the needed data or work from already logged data. The workflow when logging 

points and creating lines in Infield Design is almost the same as when logging regular as-built data.  

 

1. Click the icon for the data you need to log.  

2. Place the tool point in the correct position.  

3. Click the Add point from TP-button on the screen. This will log a point.  

 
 

4. Move the tool point to the next position.  

5. Repeat until all desired points are placed and click the OK button.  
 

Please note: If you close the pop-up window by pressing the X, all data created before pressing OK 

will be deleted, and it is not possible to recover it.  
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4.5.2. Info box for line 
When a line is created, you can access its relevant information. Simply select the line and click the 

Info-button on the left-hand side of the screen. This will open a pop-up window. 

 

 

 

 

4.5.3. Create a boundary  
1. When the points are logged, click the Add surface-button.   
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2. Click the Boundary-button. 

 

 
 

3. Select the points there are a part of the boundary and click OK. 

 

 
 

4. A boundary has been created.  
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4.5.4. Calculate volume  
1. Start by creating a surface based on your boundary.  

2. Click the Add surface-button.  

3. Click the Boundary-button and select the created boundary. When selected press OK.  

 
 

4. Select the top points to create the surface. When the points are selected, click OK to create 

the surface.   
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5. Select the surface and click the Volume to boundary-button to calculate the volume. 

 
 

6. This will open a pop-up window showing the volume.  

 
 

7. If more information is needed, click the Info-button to open the info box.  
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4.5.5. Infield Design report   
It is possible to create an Infield Design report with all the relevant measurements. Create the 

report by clicking the Make report-button, this will export the data to Makin’ Cloud. Please note that 

the report can only be generated once the volume has been calculated and Infield Design has 

collected all the relevant data. 

 

 

 

Go to the cloud and open the PDF. Please note that the image in the report is a screenshot taken at 

the moment when ‘Make Report’ is clicked. It is therefore important to be aware that the screen 

displays the measured area if you want to have the correct area shown in the report.  
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4.5.6. Exiting Infield Design  
To exit the Infield Design click the Exit Infield -button or the Infield Design icon at the bottom of the 

screen.  
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4.6 Geodetic systems 
Only in rare cases should the machine operator be concerned about selecting the correct coordinate 

system and geodetic model. With Makin’ 3D these matters are handled in a central place - e.g., the 

construction office. When made available, the geodetic system cannot be changed on the 

compactor. It is possible though, to handle the geodetic system locally when required by simply not 

having it preselected for a particular project. 

 
 
 

4.7. Project offset 
Project offset is designed to adjust a machine's height to match the height of the design project you 

are working on. Even if a machine is correctly calibrated, the height measured by the tool point in 

the application can differ from the height of a known point on the project. These differences can 

occur as a result of differing reference systems, e.g.: localized coordinate projections vs. official 

coordinate projections. Other sources include small variations between GNSS manufacturers as well 

as incorrect heights used in the initial project design. 

To mitigate this, we have added the project offset functionality, which adjusts the received GNSS 

height (not the antenna height) to match the height of the known point on the project.  

 

 

Note: 

Project offset is limited to adjustments of +/- 50 cm. 

 

Project offset can be adjusted in: Main Menu > Project > Project offset 
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How to use: 

1) Inside the project offset menu, you will see the tool point height of your application in the 

value area. 

 

2) Enter the correct height of the known point in the value area to calculate a project offset. 

 
3) It is also possible to adjust the project offset using the +/- buttons, increasing or decreasing 

the value by 1 cm per tap.  

 

4) A project offset is calculated and visible in the project menu. When you have a project offset, 

the icon will be visible on the work screen.   

 

 

To remove the project offset, go into the Project Offset menu and tap the trash can icon. 
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4.8. Change offset 
 

Entering this menu adjusts the height offset you want to have for the whole project. Typical uses are 

where you have only been given the surface of a road and should dig for a ditch or other layers 

beneath the surface. If the ditch is known to be 0.85 meters under the finished road, then adjust the 

offset value to -0.85. A parallel surface/line will then be created 0.85 meters beneath the theoretical 

model. The whole model will be offset.  

You can enter the desired value manually or move your finger up or down in the vertical field. 

 

 

 

If you have applied an offset but want to view the model with its original offset, enable 'Show Original 

Model'. 
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5. Display 
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5.1. Labels 
A label is the name of a geometry object of the following type: 

● Points 

● Lines 

● Surfaces 

● Stations 

● Log Points 

● Log Objects 

● Texts 

 

It is possible to choose which type of label should be visible by selecting/deselecting it on the list. 
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5.2. Screen indicators 
It is possible to hide some of the screen indicators in the work screen area. This function is 

designed to let you remove non-essential features, that could be distracting on the screen.  

 

With all screen indicators:  

 

 

With selected screen indicators:  
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5.3. Use file color 
This feature changes between using the colors stored on file or the default color scheme of Makin’ 

3D. In some situations, it gives a better overview using the colors of the model file and will make it 

easier to separate elements in a complex file.  

If file color is not enabled, Makin’ 3D will use default colors. 

Be aware that some files can include black-colored lines or designs, and these will not be visible if 

the file color is selected. 

 

● Tap to select/deselect file colors 
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5.4. Show maps 
The user can hide or show maps along with the project to get a better overview. The map will be 

shown below the lowest active 3D reference in the project. 

The tool cuts are shown on the map in Top View. Otherwise, tool cuts are only shown on elements 

of the 3D model marked as a height reference. 

Note: In the 3D View, the map will be seen in a perspective view. If you want to see it straight from 

above, use the Top View instead. 

 

● Tap to select/deselect visibility of map 
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5.5. Show other systems 
Other systems currently working on the same project—like machines, rovers, etc.—will show up. 
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5.6. Show textures 
Instead of using solid colors, you can have textures shown. This is only possible with road geometry. 
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5.7. Tool point coordinates 
You have the option to show or hide the tool point coordinates in the app. When activated, the 

coordinates for north and east will be displayed along with the height. If deactivated, only the height 

will be shown. 
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5.8. Auto hide quick keys 
Auto Hide Quick Keys will hide the “quick keys” at the bottom of the screen after about 8 seconds of 

not touching the display. 

When you touch the display, they become visible again. It will give you a clearer view of what you are 

working on when icons are hidden. 

 

 
 
 

5.9. Reverse quick keys 
This feature places the quick keys to the right of the menu button. It makes it more convenient to 

log points from the right-hand side of the screen without having to visually locate the point logging 

feature. 
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5.10. Transparent surfaces 
Hide the surfaces to be able to see lines and points beneath them. 

Note: Surfaces with textures will not be transparent. 

Warning: Reference selection is not visible when transparent surfaces are enabled. 
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5.11. Dark theme 
By default, the machine control system has the ‘Dark theme’ enabled, which is great at night time or 

when working in dimmed conditions. It is recommended to disable this feature when working in a 

bright environment, especially while working in direct sunlight when staking out points outside the 

cabin, etc. 
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5.12. Wireframe 
Tap Wireframe to enable the triangular design to be visible. This will show the edges of the triangles 

and might improve their visibility. 
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5.13. View settings 
To obtain a better overview of your work, you now have the option of hiding the excavator or making 

it transparent. 

 

Open the menu and select Display. Scroll down to View settings. 

It is possible to set this individually for a work situation or when you touch the screen. You can also 

choose individual settings for work screens with 3D View or Top View. 
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6. Settings 
 

 

 

 
 

 

6.1. Language 
Select the language of your choice. The language is automatically changed and saved. 
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6.2. Length unit 
Tap to choose the length unit. It is automatically changed and saved. 

 

     

 

 

 

6.3. Angle unit 
Tap to choose the angle unit. The angle unit is automatically changed and saved. 
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6.4. Sound Volume 
Tap the sound volume again and again to change the sound level. Choices are given: Low, Medium, 

High, Highest. 

 

 

 
 
 
 

6.5. Area selection  
The ‘Area selection’ feature makes selecting objects in areas with many elements (such as points, 

lines, or surfaces) easier. When you tap on an area with multiple elements, a list of up to 7 nearby 

objects will appear on the screen, which you can choose from by tapping on the object you want to 

select. The objects listed are the ones closest to the spot you have most recently tapped. A ring will 

briefly appear on the screen to indicate the area you are selecting. 
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You can enable or disable this feature in the Settings menu. When ‘Area selection’ is disabled, only 

one object will be selected when you tap on the screen. 
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6.6. Calibration backup 
You can save a backup of the machine's current calibration file. If the same tablet is used on 
different machines, you can also save each machine's calibration as a separate backup, making it 
easy to access the correct file. 
 
 
 

6.6.1. Snapshots 
Every hour, the snapshot function automatically creates a backup file of the current calibration, or 
whenever changes are made to the calibration. Please note, however, that if multiple changes are 
made within the same hour, the previous file will be overwritten. 
 
You can at any time change back to a previous calibration by selecting a backup file, as described 
in section 6.6.3: Select Backup File.  
 
Please note that at the end of the day, the system automatically reviews the day’s backup files and 
clears the list so that only the latest calibration remains available 

 
 

 
 

6.6.2. Manual backups 
To manually create a backup file, follow the description below.  
 

Step Action Illustration  

1 Open Machine configurations in the 
Settings menu.  
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2 Select MyMachine. 

 
3 Select Manual backups. 

 
4 Tap the + icon to create a new backup.  

 
5 Give the backup a name.  
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6 Save by tapping the check mark.  

 
NB! The backup file will now be visible in the 

Manual backups menu.  
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6.6.3. Select backup file 
Please note that the procedure for selecting a backup file is the same for snapshots and manual 
backups. 
 

Step Action Illustration  

1 Tap on the calibration file you want to 
apply to your system. 

 

 
2 A notification appears on the screen. 

Tap on the check mark to confirm. 
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7. Logging (As-built) 
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7.1. Log Point 
1) Press the Layers icon to open the layer overview. 

 
2) Select the layer that you want to log data into. Please note that if you do not choose a layer, 

the data will always be logged at the Bottom layer. 
 

Note: It is very important to switch to the next layer once you have completed the compaction of a 
layer — meaning that the required values have been achieved. 
 

 
 
 
The color of the heatmap is, by default, determined by the reference height. The heatmap will be 
colored according to the height tolerance colors and will be updated when the height tolerances are 
changed.  

 
When working outside the model, the coloring will be gray. 
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7.1.1. Vibrations 

Please note that if Vibration activated logging is activated, the logging of the data will only occur 
when the vibration on the Compactor is turned on. This function is toggled on/off in the 
Compactor settings menu.  

 

 

 

Please note that the final pass can be logged without vibration, provided that the Vibration 
activated logging function is disabled.  
 
 
 

7.1.2. As-built 

Log Point is an as-built feature used to document points. You can access it from the Logging 

menu. 
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1) Tap ‘Object’. A list of your most recently used objects will appear. 

If no objects are shown, click the folder icon, then select a group of objects to find the one 
you need. 

 

            

 

2) Choose the object group that suits your task. 

 

 

 

3) Select the relevant object from the list. 
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4) Once the object is selected, tap the Log point icon in the bottom right corner to log a point. 
 

 
 
 

5) A notification will confirm the point has been logged, including the point number and object 

details. 
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You can press ‘undo’ if you regret your last logging. The confirmation pop-up will disappear after 

approximately 10 seconds. 

Note! The last used object will remain active until it is changed. 
 

 

 

 

7.2. Object information and attributes 
When a point is logged, several different pieces of information are logged together with the object 

and coordinates. Below, you can see a list of information with an explanation of the different values.  

Point name: A unique name used to identify 
individual points 

N: The measured points northern coordinate. 
This value is measured on the tool point 
 

E: The measured points’ eastern coordinate. 
This value is measured on the tool point 
 

H: The measured points elevation. This value is 
measured on the tool point 

VRMS: Shows the vertical accuracy of the 
GNSS when the point was logged. Accuracy is 
defined on the GNSS antenna, not the tool 
point 

HRMS: Shows the horizontal accuracy of the 
GNSS when the point was logged. Accuracy is 
defined on the GNSS antenna, not the tool 
point 

Mount point: Shows which mount point was 
chosen for the connected NTRIP server 

Project offset: If an application has a project 
offset entered to adjust tool point elevation to 
match the elevation of a known point on the 
construction site.   
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ExtSurf: Showing if the point measured is done 
on an extended surface value can be 0(no) or 
1(Yes) 

ToolHeight: Shows the height offset applied to 
the measured tool point, e.g. Pole height for 
Makin’ Survey, or Tablet height for Makin’ 
PerFormans 

Time: The time where the point was logged 
logged in a YYYY-mm-dd HH:MM:ss format 
Example: 2022-02-15 09:43:34 

SystemName: Shows the name of the system 
that logged the point. This system name 
matches the system name on the Cloud 

PDOP: Dilution Of Precision, indicates how 
errors in measurement will affect the absolute 
position calculation. Dop can be calculated in 
different variants. (HDOP, VDOP, PDOP, TDOP, 
GDOP)  
The DOP value logged in the as-built data is the 
PDOP value. (Position dilution of precision) 
This can be considered as the 3D DOP. The 
value is relative and not related to a specific 
measurement unit.  

Sats: Showing how many satellites were visible 
when the point was logged. The value is the 
sum of satellites, and not divided into specific 
satellite constellations (GPS, Glonass, Beidou, 
Galileo)  

LogOffset: Delta height. Shows if the operator 
has added an offset to the logged point. Often 
used if it is impossible to log the exact position 
due to limited space. E.g., logging the inlet in a 
manhole. Then the operator can log a point on 
the top of the manhole, measure the distance 
from the measured point to the inlet, and enter 
this as a delta height.measured. Value shows 
accuracy in meters   

SiderefFile: Side reference file. Shows the 
name of the file used as active side reference 
when point was logged 

App: Shows which system has logged this 
specific point. 

SiderefName: Side reference name. Shows the 
name of the specific reference inside the 
reference file, used as an active side reference 
when a point was logged. 

HeightOffset: If the operator has entered an 
offset, the value is documented in this field. 
This offset will have a direct effect on the Href 
value. 

Sidedist: Shows the horizontal distance from 
the tool point to the side reference when the 
point was logged. 

POI: This is set if the operator has marked a 
point as a Point Of Interest. The value can be 0 
(no) or 1 (yes). 

HeightrefFile: Height reference file. Shows the 
name of the file used as the active height 
reference when the point was logged. 

Height: Shows the vertical distance from the 
tool point to the height reference when the 
point was logged. 

HeightrefName: Height reference name. 
Shows the name of the specific reference 
inside the reference file, used as the active 
height reference when the point was logged. 
 

 Comment: If the operator has written a 
comment for the point, it will be shown here. 
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8. GNSS 
 

 

 

 

Settings related to GNSS can be viewed in this menu. 
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9. Chat 
The chat feature helps you communicate with your colleagues about the project you are working on. 
 

 
 
 

You will see all office personnel and coworkers from your company or project. This depends on the 

structure created by your management. 

 
1. Tap a contact from the list to begin messaging. 

 

2. Write a message and tap ‘Send’. 
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10. Status 
This is where you will find various details about the system information. 
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Tap ‘GNSS’ to see the connection status and your location. 
 

Tap ‘Sensors’ to see detailed sensor information. 
 

‘Version’ is the current Makin’ 3D software version of the Android app running on your tablet. 
 

‘IB-1 version’ is the firmware version of the interface box connecting all the sensors to the system. 

 

     

 

System info: You can find all relevant information about your system by selecting ‘System info’. 

Information such as System name, System number, System owner, and the associated licenses are 

shown here. When changes are made to the system, they will be shown under System info. 
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11. Troubleshooting 
 

Error message Possible cause Possible Solution 

   

   

   

   

   

   

   

   

   

   

   

   

 

If you cannot solve the problem using the advice found in the above table, contact your reseller. 
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12. Appendix 

12.1. Software updates 
When updating the Makin’ 3D app to a new version, you might receive a notification from Google 

Play Protect. To proceed with the installation, allow Google Play Protect to scan the app. This 

ensures the new software version is safe to install. 

 
 

1) Tap on ‘Scan app’. 
 

 
 
 
 
 

2) Tap ‘Install’. 
 



 

                                     Makin' Compactor User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        88 

 
 

 
 

3) The Makin’ 3D app is now updating to a new software version. Please wait while the update 

is installed. 

 
  



 

                                     Makin' Compactor User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        89 

12.2. GNSS limitations 

Always take into consideration where your machine is located. Especially when 

the construction site is within city limits with tall buildings or other obstacles. 

Also, if working near forest and mountain areas, interference could block the signal from one or 

more satellites and cause poor precision. Reflections could also occur. 

Makin’ 3D will inform you if there are not enough visible satellites or if your CQ/DOP is too high. 

 

 

1. Direct signal blocked 3. Multipath errors 

2. Direct signals perfectly received   
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12.3. Frequency 
In situations where you have to specify the frequency according to a channel, refer to the table below 

for guidance. Channel 0 is the center frequency, and channels are distributed with a 25 kHz spacing 

(in this example). 

 

Channel Frequency (MHz) 

0 446.6000 

-1 446.5750 

-4 446.5000 

-5 446.4750 
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12.4. Compliance information 

This product is intended to be mounted on earth-moving machinery exclusively for professional use, 

i.e. the product falls into the category: non-road vehicles exclusively for professional use. Makin 

hereby declares that the system and its components fulfill the requirements of the following EU 

directives applicable to this product category: 

 
 

● 93/68/EEC - CE conformity marking 

● 2014/53/EU - Radio Equipment Directive 

● 2014/30/EU - EMC directive 

○ DS/EN/ISO 13766-1:2018 - Earth-moving and building construction machinery — 

Electromagnetic compatibility (EMC) of machines with internal electrical power 

supply — Part 1: General EMC requirements under typical electromagnetic 

environmental conditions 

○ DS/EN/ISO 13766-2:2018 - Earth-moving and building construction machinery — 

Electromagnetic compatibility (EMC) of machines with internal electrical power 

supply — Part 2: Additional EMC requirements for functional safety 

 
 
 
The respective product category falls outside the scope of these directives: 
 

● 2011/65/EU - RoHS 

● 2012/19/EU - WEEE 
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12.5. Tablet connections 
The Panasonic FZ-A3 has connectors located in four places: on the top, on the side, inside the battery 

compartment, and at the bottom. 

 

 

 

1. Mini-jack audio output 4. 16 V DC input power for 
external charger 

2. Micro SIM card for broadband 
internet on both tablet and GNSS 
receiver  

 
5. 

 
USB-A 

 
3. 

 
Docking station connector for data 
and power transmission 

 
6. 

 
USB-C  
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12.6. Docking station connections 
 

 

 

1. 16 V DC input power for external 
charger 

3. 2x HighSpeed USB-A 2.0 

2. RJ-45 Ethernet   
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12.7. Interface Box – Status light indication 
Status information on the interface module can be read out by watching the LED just next to the 

power connector. 

 

Color Indication 

Green ON - All ok 

Flashing red Firmware issue - Contact reseller 

Yellow Entering standby 

White System check of software 

Blue Updates to software are ongoing 
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12.8 Tablet set-up - Programming the physical tablet buttons 
(Panasonic FZ) 

The Panasonic tablet has three user-programmable function keys, A1, A2, and A3. You can assign 
Makin’ 3D functions to these keys. 
 

Step Action Illustration 
1 Open the app UserButtonManager.   

 
 
 

2 Select the physical button to which you want 
to assign the Makin’ 3D function (A1, A2 or 
A3).  

 

 

 
 3 When clicked, a pop-up window will open. 

Select the desired function — it will be 
labelled Program 1, Program 2 or Program 3 
depending on the button you select in the 
Makin’ 3D app. 
 

 

 
 

4 Go to the Settings menu in the Makin’ 3D app.  
 

 

 

 

5 Open the External Buttons menu. 
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6 Click the button you want to program 
(Program 1, Program 2 or Program 3).  
 
Note:  
If the button does not appear on the list, 
press the physical button, this will add the 
option to the list.  
 

 

 

 
7 Select the function you want to assign to the 

button.  
 

 

 

 
8 Check that the function has been assigned to 

the button. The function appears beneath the 
button name. If a button has not been 
programmed, it will show the description No 
action. 
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12.9. Demo mode 
You can use your Makin’ 3D system on Windows in demo mode to gain confidence in the user 
interface. 

Please find below the shortcuts for the functions. 
 

Keyboard Action  

Space  Start/stop automatic driving  

+ Raise machine model 

- Lower machine model  

. Change view (sampling through options) 

b Rotate model left 

Shift b / B Rotate model right 

m Rotate model right 

Shift m / M Rotate model left 

n Drive forward (in direction of cab orientation) 

Shift n / N Drive backwards (in direction of cab orientation) 

s Drive forward along pre-determined line (centreline) 

Shift s / S Drive backwards along pre-determined line (centreline) 

j Jump around close to the project 

Shift j /J Jumps to the roundabout in Odense S 

u Jump to current side reference 

p Opens the Plan menu 
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o Opens the offset menu 

g Opens the jog window  

w Activate/deactivate wireframe mode  

r Refresh / Finds the model  

R Reload / reset model orientation (undoes number key modifications) 

1 Tilt model to the left (Roll) 

Alt 1 Tilt model to the right (Roll) 

2 Tilt model forward (Pitch) 

Alt 2 Tilt model backwards (Pitch)  
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12.10. Xbox controller  

You can use an Xbox controller to control the machine model in the Makin’ 3D app on your tablet. It 

is an easy way to gain confidence in the user interface. This feature is only available when you 

connect the Xbox controller to a Panasonic FZ-A3 tablet.  

 

How to connect the Xbox controller to your tablet: 

1. Go to Settings on your tablet.  

 

2. Click on Connected devices. 

 

3. Press the connect button on the Xbox controller. The button is located on on top of the 

controller (Number 4 on the image below). 

 

4. Click on Pair new device. 

 

5. Click on the available Xbox Wireless Controller on the tablet screen. Wait for the devices to 

pair. 

 

6. Your Xbox controller is now connected to the tablet and ready for use.  

 

Please note:  

The available functions depend on the machine model activated on the tablet. Use the table below 

to see the button functions for this model. 
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Button direction Drive mode 

1 Forward Drive forward 

1 Backwards Drive backwards 

1 left Turn machine left 

1 right Turn machine right 

2 Decrease turbo (stepwise) 

3 - 

4 Connect controller 

5 Power on/off 

6 - 
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7 - 

8 Increase turbo (stepwise) 

9 - 

10 - 

11 - 

12 forward - 

12 backwards - 

12 left - 

12 right - 

A Move machine down 1 meter 

B - 

X - 

Y Move machine up 1 meter 
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